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Objectives

At the end of this training session you will be able to:
. Import a table from Excel;

. Import data from a delimited text file;

. Export an Access file to Excel;

. Understand the purpose of Aggregate Functions;

. Create and run a query using count;

. Create and run a query using average;

N o oA W N =

Create and run a query using the parameter between.
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Import a Table From Excel

A query allows for table inquiries. A
query can change, delete, add, or arrange
data to tables. A query aids in gathering
information for forms and reports.

With a query a user asks questions and sets
parameters.

In this example, we are using the
AccessIII_StudentFiles folder located on
your computer’s desktop and the HCC_
Employees database.

1. Under the Objects bar, click on Tables and
click on New on the Database window toolbar.

2. After the New Table dialog box appears, click
on Import Table and click on OK.

3. Click on the down arrow to choose the file type
and select the file name to import.

e.g. Microsoft Excel and Employee_add.xls

- . - I—— = i —]
= G Em ayees SR Al diras e EEeSER DI DS i M oTnTaLy ‘._-i.__’-j@

Open & Desion (SINew | ¥

Objects @J Create ta Sign view
B 2] create table by using wizard
Tables
-_=-':| i Create table by entering data
= =1 thicampus
= F
s = thlEmpInfa
8 Reports
%4 Pages
& Macros
& Modules
Eroups
[l Favoribes

d8|

] ==
[ vl e

Datashest Wiew
Design View
Table Wizard

Impork Table
Link. Table

This wizard imports tables and
objects from an external file inko

the current database.
O

Impoi] mi

Look in! 1) AccessIll_StudentFiles & -3 | Q X E 7 Tools -
_2_ @__jEmplnyee_add.xls
My Recent

Diocuments

][ Cancel ]

[ g File name:

Iy Metworl

Microsoft Office Access {*.mdb;* .adp;*.mda;* mde; *, ade
dBASE 5 (*.dbf)
dBASE 11 (*,dbf)

Places Files of type: | Microsoft Excel (*.xls) [~]
~
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4. Select the table to insert and click on Import. & limportSpreadshest Wizard X]
e.g. Employee_add rvogtrldss:jﬁlf::e': filz contains more than one warksheet o range. Which worksheet or range

5. Select which worksheet or range to import by © Show Worksheets

. . (O show Mamed Ranges sheet2
clicking on the Show Worksheets or Show Sheet3
Named Ranges radio button.
c.g. Show Worksheets Sample data For worksheet 'Sheetl',
|1 |ID LastMNatme [FirstName MI Btrest i|
: 2 123-50-8092 [Eradley Jones= 123 Jungle St
6. Select the sheet or sheet range to import and Shbar-sz-ssms [ricketcs Fiog oeai n mele e
CliCk on Next, | 4 555-44-3333 [Pmiley ohn F1l Eeebler Rd
i???—EiEi—DlZS Dash Leroy [f360 Mended Ct
e g Sheetl i999—33—1212 Falls Blice ElZz Riwverbend Rj
] 3

7. Add a check mark by clicking on the First Row
Contains Column Headings and click on Next. tlct> ] [ enin
Adding this check mark specifies that the first
row contains a column heading.

|

Microsoft Access can use vour column headings as field names For your table, Does the First
row specified contain column headings?

8. Click on the In a New Table or In an Existing

Table radio button and click on Next Fist Row Contains Column Fieedings

e.g. In a New Table

I LastName |FirstName MI [Street
LlZS—SD—SDQZ Eradley Jones 123 Jungle 3t -
|2 [F47-582-9874 [Pricketts Floyd F9541 N. Dale Ma
i555—44—3333 Fmiley Tohn F P11l Eeebler EREd
i'?'?'?—EBB—DlZS Daszh Leroy @360 Mended Ct
i999—33—1212 Falls Llice 122 Riwverhend N
|6 111-22-3333 [Homes Geeves ES96 Fellowes i "l
< i

Cancel ] [ < Back I ek = ] ’ Finish ]
= Imporissprieadeheeivi=arnd \3
Y¥iou can stare wour datain a new table of in an existing table,
‘where would you like to store your data?
() In an Exjsting Table:

I LastName [FirscName NI |Street
L123—50—8092 Eradley Jones 123 Jungle St o
LSQT—BZ—QB?Q Ericketts [Floyd 29541 N. Dale Hs
i555—‘1‘1—3333 Fmiley John ' [Pll Eeebler Rd
i’?'?'?—EiB—DlZS Dash Leroy M 7360 Mended Ct
|5 poo-33-1212 [Falls Wlice M El2Z Riverbend F
i111—22—3333 Homwes [Geeves I EE95 Fellowes Ci v|
4 2l

Cancel ] [ < Back I Mexk = ] ’ Einish ]
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10.

Choose primary key setting and click on Next.

In this example the ID is the primary key;
however, Access can choose a primary key,.
Also you can choose a primary key or choose
not to have any primary key.

Type a name for the table and click on Finish.

e.g. tbIEmployeeAddresses

g

N U O

EEER TR
EEER TR
EEER TR
EEER TR
EEER TR

Microsoft Access recommends that you define a primary key For
wour new table, & primary key is used ko uniguely identify each
record in vour table. It allows you to retrieve data mare quickly.
() Let Access add primary ke,

(%) Chaose ry own primary key, 1D

() Ma primary ke,

LastlName ([FirstName [MI |Street
[Eradley Jones 123 Jungle 3t o
Ericketts [Floyd 9541 M. Dale Mg
Smiley John F P11 Eeebler Rd
[Dash Leroy M [7360 Mended Ct
Falls Llice 122 Riwverbend B
[Homes Geeves £ES96 Fellowes Ciﬂ
. 2
Cancel ] ’ < Back I Mext = ] [ Einish ]
=] impontsspriead shee W rzarnd \3

That's all the information the wizard needs to import your data,

Import ko Table:
thEmploveeaddresses]

[ 1 would like a wizard to analyze my table after importing the
data,

[ Display Help after the wizard is finished,

[ Cancel ] ’ < Back
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Import from a Delimited Text
File

A delimited text file contains records that
end in a carriage return. All fields are
separated from each other by a comma,
space, or special characters.

1. Click on File>Get External Data>Import.

2. Click on the down arrow to choose file type.
Locate file to import and click on Import.

e.g. File Type: Text Files
Location: Desktop>
AccesslIl_ StudentFiles
File Name: Employee_adds

3. Choose a Delimited format and click
on Next.

e.g. Delimited

File | Edit  Wiew Insert Tools wWindow Help Adobe PDF

1 Mew... Chrl+M -

= M. Ctrl4+0

1=

g

| Get External Data 4 || % Impart.

Close %] Link Table

| Save ChrHs

Page Setup...

Prink Preyview

ke

Prink. .. Chrl+P

Send To 3

Database Properties

1 G AHCC_Employees, mdb

2 TechProficiencySwy_FinanceDept. mdb

3 \Docurnents and Settings),..\cpt[1].mdb
4 \Docurnents and Settings),..\cpt[1].mdb

Exit

£L

‘Iu
© @@ X o -

| 5
Lk
[T

My Recent
Documents

@

(=]

eskio

o

My Docurnents

@ v

My Computer
-
[ File: name: & fe
L mpork
My Network. ) | :|
Flaces Files of type: |Te><t Files (% bt *, cov® kab *.asc) Cancel Iy

X]
Your data seems to be in & 'Delimited’ Format. IF it isn't, choose the Format that more correctly
describes your data.

(®)Delimited - Characters such as comma or tab separate each field

O.Fixed ‘Width - Figlds are aligned in columns with spaces between each field

L

Al ata from file: CHDOCUMENTS AND SETTINGS\ZAGOSTONDESKTOPVACCESSIIT_STL

IDOLasctNamedF irstNameONIOZcreet0StatedZipODOE =
123-50-509206radleydJones00123 Jungle StOTampa03i361l4d
1547-52Z-95740Erickett=0F loyddO539541 N. Dale MabryOTsam
1555-44-353335305wileydJohn0F09511 Keebler RAOYThorO3361z0
[f77-558-012300ashOLeroydM73 60 Mended CtOBrandon3351
F99-33-12120Fall=s041lice0WM2 122 Riwverbend RAOTemple T;I

2
Advanced... < Back L MNext = J’ Finish ]

[o o= )=

IE
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Select the delimiter type; add a checkmark to
First Row Contains Field Names checkbox
and click on Next.

e.g. Tab
Select where to store the data and click on Next.
e.g. In a New Table

Specify information about each of the imported
fields, modify Field Options (as necessary),
and click on Next. Under Indexed choose,
index format.

e.g. Field Name: ID
Indexed: Yes (No Duplicates)

== ligpure T Wi \2

what delimiter separates your Fields? Select the appropriate delimiter and see how wour text
is affected in the preview below.

Choose th that separates your fields:
(%) Tab icolon () Comma (") Space () other:
First Fow Conkains Field Mames Text Qualifier:  {none}
I LastName |FirstName |[MI |3treet

123-50-8092 [Bradley Tones

123 Jungle 3t —
I547-82-9874 [Pricketts [Floyd 2541 N. Dale Mabr

I555-44-3333 [miley (Tohn F P11 Eeebler Rd
[f7?7-88-0123 [pash Leroy 360 Mended Ct
FE9-33-1212 [Falls lLlice £1lzZz Riwverbend Rd

111-22-3333 [Homes

K1 i

reeves £596 Fellowes Cir ﬂ

Cancel ] ’ < Back [ Mext = ][ Finish ]

=

‘ou can stare your data in a new kable or in an existing table.

wihere would vwou like to store vour data?

() In aMew Table
() In an Exjsting Table:

ID Lastlame |[FirstName NI |Street
123-50-58092 [Eradley Jones 123 Jungle St =
1547-52-9574 [Ericketts Flowd 9541 N. Dale Mabr

1555-44-3333 pPmiley John ' Pll Eeebler Rd
F77-88-0123 |[rash Leroy M @360 Mended Ct
Po9-33-1212 [Falls lWlice M El22 Riverkend Rd
111-22-3333 [Homes o]

Feeves

K1 2
Cancel ] ’ < Back. I Mext = ]’ Finish ]

596 Fellowes Cir J
-

= ImporialexisWizand| 53
‘ou can specify information about each of the Fields vou are importing.  Select fields in the
area below., You can then modify field information in the 'Field Options' area,

Field Options
Field Mame:  [ID ata Type: |Text

Indexed: ‘es (Duplicates OK) Da mot impart figld (Skip)

=

Jtreet

123 Jungle 3t —
(9541 . Dale Mabr

LastName [FirstName M
[Eradley Tones
Erickects [Floyd

Cmiley ITohn F PFll Eeebler Rd

[Dash Leroy M [f360 Mended Ct

[Falls Alice ElZ2 Riwverbend Rd
[Homes [Geeves E E596 Fellowes Cir ﬂ

Cancel ] ’ < Back I Mext = ][ Einish ]
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7. Define the primary key and click on Next.

e.g. Choose my own primary key-ID

8. Type a name for the file and click on Finish.

e.g. tblIEmployee adds

= ImportalexisWizart

HEH RN

() Let Access add primary key.

@Eghoose my own primary key, 1D

[X]

Microsoft Access recommends khat you define a primary kew For
[ wour news table. A primary key is used bo uniguely identify each
record in your table. It allows wou to retrieve data mare quickly.

LastName

Eradley
[Ericketts
[Smiley
[Dash
[Falls

() Mo primary key.
FirstlName [MI |Street
Jones 123 Jungle St
[Floyd 9541 N. Dale
Tohn F11 Keebler ERd
Leroy 360 Mended Ct

Wlice
Geeves

o= = A

Elz2 Riwverkhend Rd
598 Fellowes Cir

-
Mabr

i

Cancel

][ < Back I Text = ]’

Finish ]

= IrmportExisWirzant

&3

That's all the infarmation the wizard needs ko import wour data.

Impott ko Table:

thIEmployves_adds|

[ 1 would like a wizard ko analyze my table after importing the

data.
[] Cisplay Help after the wizard is finished,
(o ] [
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Export an Access File to Excel

In this example, click on Tables under
Objects and select the table tbIEmpInfo.

1. Select the object to import.
e.g. tbIEmplnfo
2. From the menu bar, click on File>Export.

3. Click on the down arrow to choose the file type
and locate the file name.

e.g. File type: Microsoft Excel 97-2003
File: tbIEmpInfo

4. Add a checkmark to the Save formatted
checkbox and click on Export.

;.j HECEEmpIoyeEsS gl abasel B cees e S i U DI esroTmHlL. J u_j a
[fopen blpesion Jmew | X | 2o T |E|EE
Objects EI_:J Create table in Design view
1 Tables | 2] creats table by using wizard
= .
_::l e _=J Create table by entering data
3 1 Tablet
SRR =] Tablez
il Reports 5 thic
¥4 Pages &
7 Macras
& Modules
Groups
[#]| Favarites

File | Edit  Wiew Insert  Tools  Window ﬂell

B, L, Chrl+m

I=

&M, .. |+

B
=

5

Gek External Data 3

Close

Save Chel+5

Save As. ..
H Export. .. e
By PR T a‘

Save in: 125 AccessIll_StudentFiles D 3 - | Q x [y 2~ Tools ~
IZIJEmnluyee_add.x\s

My Recent
Dacuments

Desktop

My Documents

<)

& i€

- File name: Employes_add.xls D ESave Formatted: Expart
My Network, [ Autostart
Places | Save astypet |Microsoft Excel S7-2003 (* xis) [~]
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Aggregate Functions

Aggregate functions within Access allows the user to carry out simple mathematical
operations within a query. Aggregate functions (operations) include sum, average,
minimum, maximum, count, standard deviation and variance. Aggregate functions can
be accessed by selecting the Totals button on the query design toolbar or typing the
aggregate function in Total row of the Design grid.

Aggregate Function

Sum

Avg

Min

Max

Count

StDev

Var

10

Description

Determines the sum of field values. Supports
the following data types: AutoNumber,
Currency, Date/Time and Number.

Calculates the average of field values. Supports the
following data types: AutoNumber, Currency, Date/
Time and Number.

Determines the lowest field value. Supports the
following data types: AutoNumber, Currency, Date/
Time, Number and Text.

Determines the highest field value. Supports the
following data types: AutoNumber, Currency, Date/
Time and Number.

Determines the number of records in a field.
Supports the following data types: AutoNumber,
Currency, Date/Time, Memo, Number, OLE Object,
Text and Yes/No.

Calculates the standard deviation of a field value.
Supports the following data types: Currency or
Number.

Calculates the statistical variances of a field.
Supports the following data type: Currency.
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Query: Using the Aggregate
Function Count

Using the aggregate function Count is useful
when a simple count or tally of information
is required.

Use the HCC_Employees database.
1.  Under Objects bar, select Queries and double

click on Create a query in Design view.

2. Select the tables and/or queries to show and
click Add.

e.g. tbIEmplnfo

= e e SR Ve IS E R G EE S R

AR

Chijects @ ECreate guery in Design viewé

Queties

Faorms
Reports
Pages

Macros

U E [ o

Maodules

Groups

[ Favorites

Tables @ Creake query by using wizard

SOVl e e

Tables | Queries | Both

tI:uICamEus e

Close

PX]
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3. Double click on the field name from the table or e - |
query twice to appear in the Field design grid. S Sty 7 Selet iy = "j%
the Query Design toolbar. The Total row now

appears in the design grid between Table and
Sort. Em B

]

e.g. Campus.

4. Click on the Totals z button located on

Salary
Gender
StartDate

||
=

[ <]

5. Select the aggregate function on the second field _ A
Field: | Campus Zampus —
and click on the Run 'f button. Table: [tblEmpInfa tblEmpInfo = |
Total: |Group By Zount °|7
Sort:
e.g. Count. o !
6. Result of query using the aggregate function C”ter;‘?f =
Count. G B
7. Save the query as qryCntCampus.
= e R e B e JJE1
Campus | CountOfCampus
ER-Brandon v 3
| |DAD-District Administrative Office 3
| |DM-Dale Mabry E
| [MacDill 1
| [PC-Plant City 1
| |SPC-Zun Paint Center a
Y B-Yhar 3
Record: E 1 E]@ of 7

Activity

Create a query for gender using the aggregate func-
tion Count. Save the query as qryCntGender

How many are males? How many are females?

How could using the aggregate function Count be
useful to you?

12
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Query: Using the Aggregate
Function Avg

Using the aggregate function Avg (average)
is useful when an average of information is
required.

Use the HCC_Employees database.

In this example, we are determining the
average salary by campus.

1.  Under Objects bar, select Queries and double
click on Create a query in Design view.

2. Select the tables and/or queries to show and
click Add.

e.g. tbIEmplInfo

E:j Clueties

-3[ Forms

Reports
Pages

Macros

W E

Maodules

(aroups

3 Favorites

i .
Chjects @ iCreate query in Design view! o

& Tahles Create query by using wizard

T

oWl e

2|

Tables | Queties || Both

thICamEus e

Close

13
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Double click on the field names from the table
to appear in the Field design grid.

e.g. Campus and Salary.

Click on the Totals button located on
the Query Design toolbar. The Total row now E'E'l""':"-'s _
appears in the design grid between Table and GZ:;L "
Sort.
Select the aggregate function on the second field
i
and click on the Run button. — .
e.g. Avg. Field: |Campus Salary :
Table: |tblEmpInfo thIEmpInfo =
Result of query using the aggregate function Tatal: | Group By Group By|
Sortk: Garoup By
Average. Shan: Surm T
Save the query as qryAvgSalaryCampus. Criteria: w_
ar:
Macx
Zaunk
SkDew
War

= TR e E T AL ITE T

= ryAveciSelentOeny,

A=)

Campus | AwgOfsalary |

|} |BR-Brandon $33 466.67
| |DAD-District Administrative Office $38,500.00
|| Dh-Dale Mabry $32 433.33
| MacDill 0 §52,000.00
__|PC-Plant City $39,200.00
| SPC-Sun Point Center $15 86667

B-Yhor $33,033.33
Recaord: E [ 1 E]@ of 7

Activity

Create a query for the average salary by gender using
the aggregate function Avg. Save the query as
qryAvgSalaryGender.

How what is the average salary for males? What is
the average salary for females?

How could using the aggregate function Avg be use-
ful to you?

14
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Query: Using Parameters
Between

Creating a parameter query allows you to
search for information in fields. However, for
the parameters to function, you will have

to enter the criteria and prompt (question)
that will appear in the parameter dialog box.

Use the HCC_Employees database.

In this example, we are determining the
names of the people whose start date is
between 1/01/1980 and 12/31/99.

1. Under Objects bar, select Queries and double
click on Create a query in Design view.

2. Select the tables and/or queries to show and
click Add.

e.g. tbIEmplnfo

= FICC Bl yaas S GG UGS ldeas s

mEn

Open & Design “SNew | X | 2o S-S

Chjects ECreate guery in Design viewé

Queties

Farms
Reports
Pages

Macros

W E [ o

Maodules

Groups

[ Favorites

Tables @ Creake query by using wizard

T

oWl e

2|

Tables | Queties || Bokh

thICamEus

Close

15



Hillsborough Community College - Professional Development Services

Double click on the field names from the table
to appear in the Field design grid.

e.g. FirstName, LastName, and StartDate.

Under StartDate Criteria type the following:
Between [Beginning Start Date] And [Ending
Start Date].

Click on the Run H button and enter the
following parameters Beginning Start Date:
1/01/1980 and Ending Start Date: 12/31/1999.

Result of query using the parameter Between.

Save the query as qryBtwnStartDate.

_‘fﬂ =gl s dalae =gy Jdﬂl
B
Exempt [~]
Campus
Salary
Gender Q'
StartDate L [
am B
2
Field: |Firsthame LastName StartDate D
Table: |tblEmplnfa thlEmpInfo tblErmpInfo L=
Sark: Ascending Ascending
Shaw:
Critetia: Between [Eeginning Start Date] And [Ending Start Date]
or:
[ | 1>

1
T LE TR A TATIE LE N el [TE R iﬂ

Beqinning Start Date

1/01/1950

I Ok, II Cancel I

e= \0ierylaSeleciiiiery.

& =1 E3}

First Mame | LastMame | StartDate

|| Charlie Ealdwin 62111982
. |Rosa (Garcia 5M5/1593
___|Emie Hanz 31371996
| [Margo Marcus 12141393
|| Mlelvin Martin 5171999
| |Albert Stein 5161995
___|Dehbhie Turnipseed A/15/1995

4 |

Ecurd: [E][I] |78 [E] of &

Activity

Create a query using parameters. The query will show
the names of people, salary and campus. Save the
query as qryBtwSalaryCampus.

Show how many people make between $30,000 and
$40,000 and at which campus he/she works.

What are the results for each campus?

16
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